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Intended Audience 
This document is intended to be read by those with a fair understanding and exposure 
to the concepts involved in both testing and development and in enterprise 
integration. 

Scope 
This document covers the HP Quality Center add-in for IBM Rational Integration 
Tester. It is assumed that you are already familiar with the version of HP Quality 
Center that you will be using. 

Users of this document are assumed to have some experience using Rational 
Integration Tester and some of its core functions such as Tagging, Data Validation, 
creating reports, and running tests. Please refer to IBM Rational Integration Tester Getting 
Started Guide and IBM Rational Integration Tester Reference Guide for more information. 

Typographical Conventions 
The following typographical conventions are observed throughout this document: 

Type Usage 

Constant Width Program output, listings of code examples, file names, 
commands, options, configuration file parameters, and literal 
programming elements in running text. 

Italic Document title names in statements that refer you to other 
documents. Also used to highlight concepts when first introduced. 

Bold Menu items in graphical user interface windows (such as 
Microsoft Windows-based or UNIX X Window applications) from 
which you select options or execute macros and functions. 

Submenus and options of a menu item are indicated with a 
“greater than” sign, such as Menu > Submenu or Menu > 
Option. 

Contacting IBM Support 
To contact IBM Support, see: www.ibm.com/contact/us/en/ 
 © Copyright IBM Corp. 2001, 2012 v 
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Clients 

Installation on Quality Center 9 or 
10 Clients 

Customizing Your Quality Center 
Workflow 

© Copyright IBM Corp. 2001, 2012 
This chapter describes how to 
install and register the 
components that enable the 
bridge between Rational 
Integration Tester and HP 
Quality Center. Information is 
also provided about 
customizing your Quality 
Center workflow. 
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1.1 Overview 
The Rational Integration Tester add-in for HP Quality Center provides a way to 
integrate the powerful test creation and execution functionality of Rational 
Integration Tester with the organizational structures provided by Quality Center. 

To integrate with HP’s tools, a series of files are provided that enable the Quality 
Center client to locate and execute tests and suites from a Rational Integration Tester 
project. All modifications required for the integration are performed on the Quality 
Center server, and any clients connecting to such servers are automatically updated to 
enable the Rational Integration Tester functionality. 
 © Copyright IBM Corp. 2001, 2012 2 



 
 

 

 
 

 
 

 
 

 

1.2 System Requirements 
Your machine must meet the minimum requirements and recommendations of a 
Quality Center client, as well as those of a Rational Integration Tester client. 

NOTE:	 Some Quality Center hardware requirements exceed those of Rational 
Integration Tester. For up-to-date information about Quality Center 
hardware and software requirements, visit the HP website. 

1.2.1 Supported Versions 

• Rational Integration Tester 5.x 

• HP Quality Center 9.0, 9.2, 10, and 11 

1.2.2 Supported Web Browsers 
The following table outlines which web browsers work with different versions of 
Quality Center. 

Browser QC 9.0 QC 9.2 QC 10 ALM QC 11 

Microsoft 
Internet 
Explorer 6.0 
Service Pack 1 

Yes Yes Yes (Refer to HP 
documentation) 

(or later) 

Microsoft 
Internet 
Explorer 7.0 

(Refer to HP 
documentation) 

Yes Yes Yes 

Microsoft 
Internet 
Explorer 8.0 

(Refer to HP 
documentation) 

(Refer to HP 
documentation) 

Yes 

NOTE: Requires 
Patch 5 (or 
later). 

Yes 

Microsoft 
Internet 
Explorer 9.0 

(Refer to HP 
documentation) 

(Refer to HP 
documentation) 

Yes 

NOTE: Requires 
Patch 23 (or 
later). 

Yes 

NOTE: Requires 
Service Pack 2 
(or later). 

NOTE: The Quality Center Explorer Add-in, which can be downloaded from 
the HP website, enables you to use Quality Center without using a 
 © Copyright IBM Corp. 2001, 2012 3 



 web browser, such as Microsoft Internet Explorer. However, this add-
in cannot be used with Rational Integration Tester. 

1.2.2.1	 Security and Active X 
When using Quality Center 9.2 (or later), security warnings will be displayed when the 
customized components are loaded in your browser. You will need to grant these 
components permission to run if you want to continue. 

If desired, click the arrows next to More options and enable the Always run 
software from “Green Hat...” option to stop the security dialogs from popping up 
every time you run Quality Center. 
 © Copyright IBM Corp. 2001, 2012 4 



 

 

  
 

  
   

 

 

NOTE:	 Clients accessing the Quality Center server will also need permissions 
to install and run Active X components in their browser. 

1.2.2.2 Configuring Microsoft Internet Explorer 8.0 (or Later) For Use With Quality Center 9.2 (or 
Later) 

In addition to any Quality Center patches or service packs that need to be installed if 
Microsoft Internet Explorer 8.0 (or later) is being used, the changes in the following 
table need to be made to Internet Explorer to enable the browser to work with 
Quality Center 9.2 (or later). 

Internet Explorer 8.0 (or Later) Instructions Configuration Change 

Disable memory protection.	 1. Open Internet Explorer 8.0 (or later) “as 
administrator”. 
2. On the toolbar, click Tools. 
3. On the Tools menu, click Internet Options. 
4. On the Internet Options dialog box, click 
the Advanced tab. 
5. On the Advanced tab, under Security, 
clear the Enable memory protection to help 
mitigate online attacks check box. 
6. Click Apply. 
7. Click OK. 
8. Quit Internet Explorer to apply the 
change. 
 © Copyright IBM Corp. 2001, 2012 5 



  

  
 

    

 
 

  
  

 
 

  

  

 

 

  
 

  

  
  

 

 
  

  

Internet Explorer 8.0 (or Later) Instructions 
Configuration Change 

Add the Quality Center Server web site to the 
“local intranet zone”. 

Specify that “Local intranet zone” and 
Quality Center run in “Compatibility mode”. 

NOTE: Internet Explorer 8.0 (or later) 
adheres more strictly to World Wide Web 
Consortium (W3C) standards than Internet 
Explorer 7.0 (or earlier), so Compatibility 
mode is provided in the browser to enable 
users to view pages that would otherwise 
not be displayed (properly). 

1. Open Internet Explorer 8.0 (or later). 
2. Open the URL of the Quality Center 
Server. 
3. On the toolbar, click Tools. 
4. On the Tools menu, click Internet Options. 
5. On the Internet Options dialog box, click 
the Security tab. 
6. On the Security tab, click the Local 
intranet zone. 
7. Click Sites. 
8. On the Local intranet dialog box, click 
Advanced. 
9. On the (Add/Remove) Local intranet 
(zone) dialog box, the Add this website to 
zone field is populated with URL of the 
Quality Center Server (if the field does not 
contain the correct URL, modify it). 
10. Click Add. 
11. Click Close. 
12. Click OK on the Local intranet dialog 
box. 
13. Click OK on the Internet Options dialog 
box. 

1. Open Internet Explorer 8.0 (or later). 
2. Open the URL of the Quality Center 
Server. 
3. On the toolbar, click Tools. 
4. On the Tools menu, click Compatibility 
View Settings. 
5. On the Compatibility View Settings dialog 
box, the Add this website field is populated 
with URL of the Quality Center Server (if the 
field does not contain the correct URL, 
modify it). 
6. Click Add. 
7. Select the Display intranet sites in 
Compatibility View check box. 
8. Click Close. 
 © Copyright IBM Corp. 2001, 2012 6 



 

   
 

 

 

 

 
 

 
 

 

 
 

 

 

 

 

1.2.3 Client Requirements 
Quality Center will be accessed from the client workstation where Rational 
Integration Tester is installed. 

•	 The following table lists minimum hardware requirements for different versions 
of the Quality Center clients. 

Minimum QC 9.0/9.2 QC 10	 ALM QC 11 Requirement 

CPU Pentium III	 Pentium 4, 2 GHz (or Core Duo 1.6 GHz 
higher) (or higher) 

RAM 512 MB	 1 GB 2 GB 

Free Disk Space 300 MB	 1 GB 2 GB 

• The following table lists the different versions of Microsoft Windows supported 
by different versions of the Quality Center client. 

QC 9.0 QC 9.2 QC 10 ALM QC 11 

Windows 2000 
Professional SP4 
(32-bit) 

Windows 2000 
Server/Professional 
SP4 (32-bit) 

Windows 2000 
Server/Professional 
SP4 (32-bit) 

Windows 20

SP4 (32-bit) 

00 

Windows XP 
Professional SP2 
(32-bit) 

Windows XP 
Professional SP2 
(32-bit) 

Windows XP 
Professional SP2 
(32 bit) 

Windows XP 
Professional 
(32-bit) 

SP2 

Windows XP 
Professional SP3 
(32-bit) 

Windows XP (SP3) 
(32-bit) 

NOTE: Recommend­
ed by HP. 

Window Vista SP1 
(32-bit) 

Windows Ser
2003 (SP2) 

ver 

Windows 7 (32 bit) 

NOTE: Requires QC 
10 Patch 12 (or 
later). 

Server/Professional 

NOTE: Requires ALM 
QC 11 Patch 3 (or 
later). 

Window Vista (SP1) 
(32-bit) 
 © Copyright IBM Corp. 2001, 2012 7 



 
  

 

 

 QC 9.0 QC 9.2 QC 10 ALM QC 11 

Windows 7 (64-bit) 

NOTE: Requires QC 
10 Patch 18 (or 
later). 

Windows Server 
2008 (R2) 

NOTE: Requires ALM 
QC 11 Patch 1 (or 
later). 

Windows 7 (32-bit) 

NOTE: Recommend­
ed by HP. 

Windows 7 (64-bit) 

NOTE: Requires ALM 
QC 11 Patch 2 (or 
later). 

NOTE:	 Depending on the operating system, specific versions of other 
Microsoft software may also be required, for example, Microsoft 
Office, Microsoft Visual C++, and Microsoft .NET Framework. 

•	 Rational Integration Tester Results Server installation is required for viewing 
detailed results for Rational Integration Tester Test Suites executed from Quality 
Center (please speak with your Green Hat sales representative if you need more 
information) 

NOTE:	 For more specific information about client requirements, refer to your 
HP documentation or visit the HP website. 
 © Copyright IBM Corp. 2001, 2012 8 



 

 

1.3 Installation Files 
To enable the integration of Rational Integration Tester and Quality Center, it is 
necessary to modify the list of existing test types and deploy additional files to the 
Quality Center server. The table below lists the files to be deployed. 

File Name Short Name Description ProgID 

GHExecConfig.x
co 

GHExecConfig.o
cx 

Rational Integration 
Tester Envs 

GHResultViewer GHResultViewer Rational Integration 
.xco .ocx Tester Results 

er 

GHRunAgent.xxx GHRunAgent.exe Rational Integration 
Tester Run Agent 

GHScriptViewer
.xco 

GHScriptViewer
.ocx 

Rational Integration 
Tester Scripts 

GHTestType.lld GHTestType.dll Rational Integration 
Tester TestType 

mscomctl.xco mscomctl.ocx MS Common Control 

RICHTX32.xco RICHTX32.ocx MS Richtext Control 
rl.1 

unzip32.lld unzip32.dll Extract DLL for 
Win32 

GHTester_ExecConfi 
g.GHT_ExecConfig 

GHTester_ResultVie 
wer.GHT_ResultView 

GHTester.RunAgent 

GHTester_ScriptView 
er.GHT_ScriptViewer 

GHTester.TestType 

RICHTEXT.RichtextCt 

NOTE:	 These files and examples of the .ini files that need to be edited are 
located in QualityCenterServerDist9x.zip, 
QualityCenterServerDist10.zip, or 
QualityCenterServerDist11.zip, which are copied to 
<Rational Integration Tester Installation 
Directory>\tools\HP. 

The contents of the .zip file should be extracted to a new directory on the Quality 
Center server. The files will be used by the detailed procedures in subsequent sections 
of this chapter. 
 © Copyright IBM Corp. 2001, 2012 9 



 

1.4	 Server Installation for Auto Deployment to Quality Center 

Clients
 
The integration files can be installed a Quality Center server for auto-distribution to 
connecting clients. The process varies according to the version of Quality Center in 
use. See the appropriate section based on your environment: 

• Quality Center 9.0 

• Quality Center 9.2 and 10 

• HP Application Lifecycle Management (ALM) Quality Center 11 

1.4.1	 Quality Center 9.0 
For Quality Center 9.0 server installations, two files in the application archive 
(qcbin.war, located by default in the C:\Program Files\Mercury\Quality 
Center\Application directory) must be modified in addition to adding the files 
listed under Installation Files 

The simplest way to modify the files is to use a file compression tool that enables you 
to browse the contents of the archive, view and edit individual files, update the archive 
with the edited files, or add files and/or directories to the archive. If such a tool is not 
available, you will need to have a suitable Java JDK installed so that you can extract 
and modify the files, update the archive with the modified files, and add the new 
server deployment files listed under Installation Files. 

NOTE:	 If you do not feel comfortable performing the steps listed below (for 
example, extracting files from a WAR file, deploying a WAR file on an 
application server), you should seek assistance from the Quality 
Center or application server administrator 

1.	 Stop the Quality Center application server. 

2.	 Make a backup copy of qcbin.war. 

3.	 To extract the required files, open a command prompt, change to the directory that 
contains the WAR file, and issue the following command: 

jar xf qcbin.war Install\test_type.ini setup_a.ini 

The files will be extracted in the same location as the WAR file. 

NOTE:	 If you are using a modified WAR file, you should extract the files from 
the modified file. 
 © Copyright IBM Corp. 2001, 2012 10 



  

 

4. Open test_type.ini (in the Install folder) and add the new test type and Class 
ID: 

[GH-TESTER]
 

CLSID={A78DFDE0-8231-FBDC-9FD1-0040CA1B8A87}
 

5.	 Open setup_a.ini and define each of the deployment files (listed under Installation 
Files) with the following section of text: 

[File_n]
 

Register=Y
 

URLName=%URL%/Install/<File Name from table>
 

ShortName=<ShortName from table>
 

Description=<Description from table>
 

ProgID=<ProgID from table>
 

Version=5.1.0.11
 

NOTE:	 Replace n in [File_n] with the next available integer (for example, 
[File_28] based on the sequence numbers that are currently used in 
the file. 

6.	 To prevent files from being downloaded each time a client connects to the server, 
ensure that the proper version is set for each of the following file definitions: 

• GHExecConfig.ocx 

• GHResultViewer.ocx 

• GHRunAgent.exe 

• GHScriptViewer.ocx 

• GHTestType.dll 

• RICHTX32.ocx 

• unzip32.dll 

• mscomctl.ocx 

The current version for each file is listed in version.txt, included in the .zip
archive that contains the files. 
 © Copyright IBM Corp. 2001, 2012 11 
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For example, the definition for GHScriptViewer.ocx might appear as follows: 

[File_0046]
 

Register=Y
 

URLName=%URL%/Install/GHScriptViewer.xco
 

ShortName=GHScriptViewer.ocx
 

Description=Rational Integration Tester Scripts
 

ProgID=GHTester_ScriptViewer.GHT_ScriptViewer
 

Version=5.1.0.11
 

NOTE:	 If any system updates are applied to the Quality Center server, you 
may need to repeat the preceding procedures, as the update may 
overwrite some of the configuration files. 

7.	 Copy the files listed under Installation Files to the extracted “Install” directory. 

8.	 Using the same command prompt from step 3, update the WAR file using the 

following command:
 

jar uf qcbin.war Install\* setup_a.ini 

9.	 If using the JBoss application server, rename qcbin.war to 20qcbin.war. 

10.	 Restart the application server and deploy the new WAR file according to your server’s 
requirements. 

11.	 After completing these steps, you can restart the Quality Center client. 

NOTE:	 If any system updates are applied to the Quality Center server, you 
may need to repeat the preceding procedures, as the update may 
overwrite some of the configuration files. 
 © Copyright IBM Corp. 2001, 2012 12 
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1.4.2 Quality Center 9.2 and 10 
Quality Center 9.2 introduced a strict security mechanism for the files included in its 
deployment. Files must be digitally signed and check-summed before they can be 
accessed via Quality Center. Because of this, the Rational Integration Tester add-in 
installation process is significantly different than for previous Quality Center versions. 

The server modifications require changes to specific files in the Quality Center 
application archive (20qcbin.war). The files can be extracted by using a file 
compression program or by using the jar command (Java JDK required). The 
20qcbin.war file is located in Quality Center’s application server directory (for 
example, C:\Program Files\Mercury\Quality 
Center\jboss\server\default\deploy\20qcbin.war). 

After the required files have been extracted from the archive, you must send them to 
Green Hat Support to be updated with the required information. Green Hat Support 
will return the updated files, along with the additional files that must be added to the 
Quality Center WAR file. These files, in addition to the required file modifications, are 
what enable the integration of Rational Integration Tester and Quality Center. 

Follow the steps below to extract the required files from your Quality Center WAR 
file. After the files are returned to you, they will be added back to the WAR file along 
with the additional files from Green Hat Support. 

1.	 Stop the Quality Center application server (or Windows service). 

2.	 Make a backup copy of 20qcbin.war and place it in a different directory. 

3.	 Extract setup_a.cab and Install\test_type.cab from 20qcbin.war using a file 
compression program or the jar command. 

4.	 Send the files as an attachment to support@greenhat.com, being sure to include your 
Rational Integration Tester version. If you are using a non-customer email address, 
please also include the customer name. 

NOTE:	 Depending on the time at which the files are received, Green Hat will 
attempt to return them as soon as possible. 

If necessary, you can restart the Quality Center server and continue to 
use it until the files are returned by Green Hat Support. 

Green Hat Support will send a .zip archive to you that includes updated copies of 
setup_a.cab and test_type.cab, as well as the files listed under Installation Files. 

5.	 When you are ready to complete the installation, stop the Quality Center application 
server if it is running. 
 © Copyright IBM Corp. 2001, 2012 13 
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6.	 Add setup_a.cab and test_type.cab back to 20qcbin.war, as well as the 
additional files that were sent from Green Hat Support. 

NOTE:	 setup_a.cab can be added to the root of the WAR file. 
test_type.cab and the other files returned by Green Hat should be 
added to the Install directory within the WAR file. 

You can drag and drop the files if you have opened the archive using a file 
compression program, or add the files using the jar command. 

7.	 When all of the files have been added to the WAR file, start the Quality Center 
application server (or Windows service). 

1.4.3 HP Application Lifecycle Management (ALM) Quality Center 11 
The Rational Integration Tester integration with HP Application Lifecycle 
Management (ALM) 11 requires the addition of a few files to the directory where the 
ALM application archive (20qcbin.war) is deployed. The 20qcbin.war directory is 
located in the ALM deployment directory (specified below). 

In addition to the server updates, the DLLs that are downloaded from the ALM 
server must be registered on each of the client machines that will access the server. 

1.4.3.1	 Server Configuration 
Follow the steps below using the Administrator account on the ALM Server 
machine to update the ALM server. 

NOTE:	 If projects containing Rational Integration Tester integration tests 
from Quality Center versions 9.x or 10.x are going to be migrated to 
Quality Center 11, the Rational Integration Tester integration must be 
deployed to the ALM Server before upgrading those projects to 
Quality Center 11. 

NOTE:	 Deployment of the Rational Integration Tester integration on the 
ALM Server requires HP ALM Patch 2 (or later). 

1.	 Shut down the HP ALM Server. 

2.	 Extract QualityCenterServerDist11.zip to a temporary location on the server. 

3.	 Locate the ALM deployment directory, referred to as <ALM Deployment 


Directory>.
 
 © Copyright IBM Corp. 2001, 2012 14 



 

  

  

  

  

 
 

On Windows 2003 Server, the default location is C:\Documents and 
Settings\All Users\Application Data\HP\ALM. On Windows 2008 Server, the 
default location is C:\ProgramData\HP\ALM. 

4.	 If they do not already exist, create the following folders in 20qcbin.war, which is 
located in <ALM Deployment Directory>\application: 

•	 CustomTestTypes 

•	 Extensions 

Copy the following files from the extracted QualityCenterServerDist11.zip 
archive as follows: 

•	 GHTesterQC11Integration\CustomTestTypes\GHTester.ini to <ALM 
Deployment Directory>\application\20qcbin.war\CustomTestTypes 

•	 GHTesterQC11Integration\Extensions\* to <ALM Deployment 
Directory>\application\20qcbin.war\Extensions 

•	 GHTesterQC11Integration\HP\ALM\repository\sa\DomsInfo\Metadata\TE
ST\GHTester.xml to <ALM Deployment 
Directory>\repository\sa\DomsInfo\Metadata\TEST 

5.	 Run the Server Deployment Wizard from Start > HP ALM Platform (click Next 
on the Welcome screen to deploy the server, then click Finish). 

6.	 Start the server if it does not start automatically. 

7.	 After ALM is started, log into Site Administrator as a user with administrator 
privileges. 

8.	 On the Tools menu, click Update Test Types and click Yes to confirm (the update 
may take several minutes). 

1.4.3.2	 Configuring Client Machines 
Using an account with administrator privileges, complete the following steps on each 
client machine that will access the ALM server before executing Rational Integration 
Tester integration tests from within Quality Center 11: 

1.	 Log into Quality Center. 

2.	 On the menu bar, click Help > Add-Ins Page. 

3.	 Click HP Quality Center Connectivity on the Add-Ins window. 

The HP Quality Center Connectivity Add-in page is displayed. 

4.	 Click Download Add-in. 

5.	 Follow the instructions provided to install the Connectivity Add-In. 
 © Copyright IBM Corp. 2001, 2012 15 



6.	 After installing the Connectivity Add-In, restart the Quality Center client to enable 
the changes to take effect. 

NOTE:	 The Connectivity Add-in enables Rational Integration Tester tests to 
be executed properly from Quality Center. 
 © Copyright IBM Corp. 2001, 2012 16 



 

 

 

1.5 Installation on Quality Center 9 or 10 Clients 
Quality Center’s auto deploy option is a simple way to enable functionality for any 
client accessing the server. In some organizations, however, auto deployment may not 
be a feasible scenario (for example, if security policies prohibit clients from having 
local admin privileges). In such cases, clients that require the integrated Green Hat 
functionality can have the plugin files deployed manually. In this way, the plugin files 
can be targeted to only the clients that require them, rather than all Quality Center 
users. 

NOTE:	 This deployment can be carried out using a batch file that is included 
with the server files in QualityCenterServerDist9x.zip (for 
Quality Center 9 users) or QualityCenterServerDist10.zip (for 
Quality Center 9.2 or 10 users), copied to <Rational Integration 
Tester Installation Directory>\tools\HP. 

Before deploying the required files to a Quality Center client, please ensure that: 

•	 Quality Center has already been installed and configured and the Quality Center 
client is installed on the local workstation. 

•	 Microsoft Internet Explorer 6.0 SP01 (or later) is installed on the local 
workstation (for more information about this, refer to Supported Web Browsers). 

•	 A domain and a project have been identified for plugging into Quality Center. 

• The  test_type.ini and setup_a files are accessible and modifiable. For 
example, if Quality Center is installed on a workstation running Windows, the 
files are probably located in C:\Program Files\Mercury\Quality 
Centre\jboss\server\default\deploy\20qcbin.war. 

•	 The user accessing the Quality Center client has sufficient privileges on the local 
workstation to modify the project, and has retrieved the test_type.ini file and 
copied it to the local workstation. 

Follow the steps below to deploy the required files to a Quality Center client. 

1.	 Log into the client workstation using an account that has local admin privileges. 

2.	 Extract the contents of the appropriate .zip file to a new directory on the client 

workstation (for example, C:\qcclient).
 

3.	 Extract test_type.ini from the Quality Center server WAR file by changing to the 
directory that contains the WAR file and issuing the following command: 

jar xf qcbin.war \install\test_type.cab\test_type.ini 

The file will be extracted in the same location as the WAR file. 
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NOTE:	 If you are using a modified WAR file, you should extract the file from 
the modified file. 

4.	 Add the following line at the end of test_type.ini file: 

[GH-Tester]
 

CLSID={A78DFDE0-8231-FBDC-9FD1-0040CA1B8A87}
 

5.	 Extract the QualityCenterServerDist10.zip file, which is in <Rational 
Integration Tester Installation Directory>\tools\HP, to C:\QC Client 
Plug In. 

6.	 Open a command prompt and browse to the directory where the above file has been 
extracted. 

7.	 Log off from Quality Center if it is still running. 

8.	 Run the GH_Client_QC10.bat file. 

9.	 Log into Quality Center. 

10.	 On the Tools menu, click Customize. 

11.	 Click Workflow on the left side of the screen. 

12.	 On the Workflow page, click the Script Editor link. 

13.	 Click the Toolbar Button Editor tab on the Script Editor page. 

14.	 Click Test Lab in the Command bar list. 

15.	 Click Add to add a new command. 

16.	 Change the following items: 

• Caption: GHTester Environment 

• Hint: Select the GHTester Environment for the selected Test Cycle 

• Action Name: TestLab_GHTesterEnv 

17.	 Using the list of available images, choose an icon to display on the new button. 

18.	 Click Apply. 

19.	 Click the Script Editor tab. 

20.	 Expand the tree on the left to show Workflow Scripts > Common Scripts > 
ActionCanExecute and select it. 

21.	 Change the script (on the right) to the following: 

Function ActionCanExecute (ActionName) 
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'Use ActiveModule and ActiveDialogName to get the current context.

     On Error Resume Next 

If ActionName = "TestLab_GHTesterEnv" Then

   If IsObject(TDConnection) Then

        Set TSTestFactory = Actions.TSTestFactory

 Set TSTest = 
TSTestFactory.Item(TestSetTest_Fields("TC_TESTCYCL_ID").value)

 Set dlg =
CreateObject("GHTester_ExecConfig.EnvSelectionHelper")

        dlg.EnvironmentDialog TDConnection, TSTest

 End If

     End If 

ActionCanExecute = DefaultRes

     On Error GoTo 0 

End Function 

22. On the File menu in the Script Editor, click Save. 

23. Close the Script Editor. 

The files are now deployed to the Quality Center client. 
 © Copyright IBM Corp. 2001, 2012 19 



 

1.6 Customizing Your Quality Center Workflow 
You can add workflow scripts to HP Quality Center to customize the user interface 
and add actions for users. For more information, refer to Quality Center Administrator’s 
Guide. 

Examples of workflow customization for Quality Center 9.0 and Quality Center 9.2 
or 10 are detailed in the following sections. In these examples, a new button is added 
to the Test Lab module that allows users to set a Rational Integration Tester 
environment for all tests in the current Test Set. 

• Customizations in Quality Center 9.0 

• Customizations in Quality Center 9.2 or 10 

• Customizations in HP ALM Quality Center 11 

1.6.1 Customizations in Quality Center 9.0 

NOTE:	 The script included in the following example is supported only with 
HP Quality Center 9.0. 

1. Launch Quality Center and log into your project. 

2. On the Tools menu, click Customize. 

3. Click Workflow on the left side of the screen. 

4. On the Workflow page, click the Script Editor link. 

5. Click the Toolbar Button Editor tab on the Script Editor page. 

6. Click Test Lab in the Command bar list. 

7. Click Add to add a new command. 

8. Change the following items: 

• Caption: GHTester Environment 

• Hint: Select the GHTester Environment for all Tests in the Test Set 

• Action Name: TestLab_GHTesterEnv 

9. Using the list of available images, choose an icon to display on the new button. 

10. Click Apply. 

11. Click the Script Editor tab. 
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12.	 Expand the tree on the left to show Workflow Scripts > Test Lab module script > 
TestLab_ActionCanExecute and select it. 

13.	 Change the script (on the right) to the following: 

Function TestLab_ActionCanExecute(ActionName)


  On Error Resume Next
 

If ActionName = "TestLab_GHTesterEnv" Then


     If IsObject(TDConnection) Then

 Set TSTestFactory = Actions.TSTestFactory

 Set TSTest = 
TSTestFactory.Item(TestSetTest_Fields("TC_TESTCYCL_ID").value)

 Set dlg =
CreateObject("GHTester_ExecConfig.EnvSelectionHelper")

 dlg.EnvironmentDialog TDConnection, TSTest

     End If

  End If 

TestLab_ActionCanExecute = Project_DefaultRes

  On Error GoTo 0 

End Function 

NOTE:	 If your script already had other action buttons defined, you will need 
to insert only the following into the existing script:

  If ActionName = "TestLab_GHTesterEnv" Then

     If IsObject(TDConnection) Then

 Set TSTestFactory = Actions.TSTestFactory

 Set TSTest = 
TSTestFactory.Item(TestSetTest_Fields("TC_TESTCYCL_ID").value)

 Set dlg =
CreateObject("GHTester_ExecConfig.EnvSelectionHelper")

 dlg.EnvironmentDialog TDConnection, TSTest

     End If

  End If 

14.	 On the File menu in the Script Editor, click Save. 

15.	 Close the Script Editor. 

16.	 Click the RETURN button to go back to Quality Center. 

The new button will now be displayed on the Test Lab toolbar. 
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1.6.2 Customizations in Quality Center 9.2 or 10 

NOTE:	 The script included in the following example is supported only with 
HP Quality Center 9.2 or 10. 

1. Launch Quality Center and log into your project. 

2. On the Tools menu, click Customize. 

3. Click Workflow on the left side of the screen. 

4. On the Workflow page, click the Script Editor link. 

5. Click the Toolbar Button Editor tab on the Script Editor page. 

6. Click Test Lab in the Command bar list. 

7. Click Add to add a new command. 

8. Change the following items: 

• Caption: GHTester Environment 

• Hint: Select the GHTester Environment for all Tests in the Test Set 

• Action Name: TestLab_GHTesterEnv 

9. Using the list of available images, choose an icon to display on the new button. 

10.	 Click Apply. 

11.	 Click the Script Editor tab. 

12.	 Expand the tree on the left to show Workflow Scripts > Common script > 
ActionCanExecute and select it. 
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13. Change the script (on the right) to the following: 

Function ActionCanExecute(ActionName)

  'Use ActiveModule and ActiveDialogName to get the current 
context.

  On Error Resume Next 

If ActionName = "TestLab_GHTesterEnv" Then

     If IsObject(TDConnection) Then

 Set TSTestFactory = Actions.TSTestFactory

 Set TSTest = 
TSTestFactory.Item(TestSetTest_Fields("TC_TESTCYCL_ID").value)

 Set dlg =
CreateObject("GHTester_ExecConfig.EnvSelectionHelper")

 dlg.EnvironmentDialog TDConnection, TSTest

     End If


  End If


  ActionCanExecute = DefaultRes


  On Error GoTo 0
 

End Function 

NOTE:	 If your script already had other action buttons defined, you will need 
to insert only the following into the existing script: 

If ActionName = "TestLab_GHTesterEnv" Then

     If IsObject(TDConnection) Then

 Set TSTestFactory = Actions.TSTestFactory

 Set TSTest = 
TSTestFactory.Item(TestSetTest_Fields("TC_TESTCYCL_ID").value)

 Set dlg =
CreateObject("GHTester_ExecConfig.EnvSelectionHelper")

 dlg.EnvironmentDialog TDConnection, TSTest

     End If 

End If 

14. On the File menu in the Script Editor, click Save. 

15. Close the Script Editor. 

16. Click the RETURN button to go back to Quality Center. 

The new button will now be displayed on the Test Lab toolbar. 
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1.6.3 Customizations in HP ALM Quality Center 11 

NOTE:	 The script included in the following example is supported only with 
HP ALM Quality Center 11. 

1. Launch Quality Center and log into your project. 

2. Select Customize from the Tools menu. 

3. Click Workflow on the left side of the screen. 

4. On the Workflow page, click the Script Editor link. 

5. Click the Toolbar Button Editor tab on the Script Editor page. 

6. Click Test Lab in the Command bar list. 

7. Click Add to add a new command. 

8. Change the following items: 

• Caption: GHTester Environment 

• Hint: Select the GHTester Environment for all Tests in the Test Set 

• Action Name: TestLab_GHTesterEnv 

9. Using the list of available images, choose an icon to display on the new button. 

10.	 Click Apply. 

11.	 Click the Script Editor tab. 

12.	 Expand the tree on the left to show Workflow Scripts > Common script > 
ActionCanExecute and select it. 

13.	 Change the script (on the right) to the following: 

Function ActionCanExecute(ActionName)

  On Error Resume Next 

If ActionName = "UserDefinedActions.TestLab_GHTesterEnv" Then

    If IsObject(TDConnection) Then

      Set TSTestFactory = Actions.TSTestFactory

      Set TSTest = 
TSTestFactory.Item(TestSetTest_Fields("TC_TESTCYCL_ID").value)

      Set dlg = 
CreateObject("GHTester_ExecConfig.EnvSelectionHelper")

      If IsObject(TSTest) Then

  dlg.EnvironmentDialog TDConnection, TSTest 
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      Else

  MsgBox "No test was selected. Please select a Test 
instance in a Test Set's Execution Grid and try again.", 48, "No 
Test Selected"

      End If

    End If

  End If 

On Error GoTo 0 

End Function 

NOTE:	 If your script already had other action buttons defined, you will need 
to insert only the following into the existing script: 

If ActionName = "UserDefinedActions.TestLab_GHTesterEnv" Then

    If IsObject(TDConnection) Then

      Set TSTestFactory = Actions.TSTestFactory

      Set TSTest = 
TSTestFactory.Item(TestSetTest_Fields("TC_TESTCYCL_ID").value)

      Set dlg = 
CreateObject("GHTester_ExecConfig.EnvSelectionHelper")

      If IsObject(TSTest) Then

  dlg.EnvironmentDialog TDConnection, TSTest

      Else

  MsgBox "No test was selected. Please select a Test 
instance in a Test Set's Execution Grid and try again.", 48, "No 
Test Selected"

      End If

    End If

  End If 

14.	 On the File menu in the Script Editor, click Save. 

15.	 Close the Script Editor. 

16.	 Click the RETURN button to go back to Quality Center. 

17.	 When prompted in the Customization Changes dialog box, specify whether the 
change is major or minor (this affects how the change is passed to users) and click 
OK. 

After users connect to the project in a new session, the new button will be displayed 
on the Test Lab toolbar. 
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2.1 Overview 
After the Quality Center/Rational Integration Tester integration is complete, users 
can create tests in Quality Center and link them to testable resources (that is, tests, test 
suites, and performance tests) in Rational Integration Tester. Tests are created as the 
new test type – GH-Tester – in Quality Center in the same way that existing test types 
are created (for example, manual tests, WinRunner tests, and so on). 

Rational Integration Tester tests are created and linked in the Test Plan module, then 
the tests are added to test sets in the Test Lab module. The results of test execution 
can also be viewed in the Test Lab module. 

For more information about each phase, see the following sections: 

• Creating Tests 

• Executing Tests 

• Viewing Execution Results 

NOTE:	 When Quality Center’s auto deploy option is enabled, clients accessing 
the server will need to have local admin privileges to download and 
install plugin files. If the client browser fails to load these files or 
seems to hang when trying, please verify that the current user account 
has the appropriate privileges. 
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2.2 Creating Tests
 
This section describes how to create Rational Integration Tester tests in Quality 
Center and link them to existing resources in Rational Integration Tester. 

1.	 Log in to Quality Center and open the Test Plan module. 

2.	 Create a new test and select GH-Tester as the type. 

After the new test object is created, you can edit all of the normal details associated 
with a Quality Center test. 

3.	 To assign a Rational Integration Tester resource to the new test, click the Test Script 
tab. 

4.	 Click Select next to the Project field to select a Rational Integration Tester project 
and testable resource that it contains. 

NOTE:	 If versioning is enabled in your Quality Center 10 project (from within 
Site Administrator) and the test has not been checked out, the Project 
and Resource controls will be disabled. In this case, you will need to 
manually check out the Test Plan test before any changes are allowed. 
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 The Resource Selection dialog is displayed. 

5. Click the folder icon  to open the Rational Integration Tester project selection 
dialog. 

6. Select the Rational Integration Tester project that contains the resource you want to 
use and click OK. 
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7. Locate and select the desired test resource within the project tree, then click OK. 

You can filter the contents of the component tree using the Configure Filters icon 

 in the toolbar, or search for specific resources by clicking the Search icon (see 
IBM Rational Integration Tester Reference Guide for more information). To expand or 
collapse the selected branch of the tree, click the or icon. 

To search the project for specific test resources, press CTRL+F to open the Find 
panel (shown above), then enter the desired search string in the text field. The first 
matching resource will be selected as you type. To jump to the next or previous 

matching resource, click the or icon. 
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8.	 A snapshot of the selected test resource will be displayed under the Test Script tab, 
back in the Test Plan module. The snapshot lets users without Rational Integration 
Tester review pertinent information about the linked test. 

NOTE:	 If desired, you can modify the Project or Resource selections 
manually. When finished, you must click Refresh to verify the 
changes and update the resource used in the test. 

NOTE:	 If other Quality Center users will execute the tests that you create, you 
should consider using UNC-based project paths (for example, 
\\<host>\<project_path>\<project>). 

If the Rational Integration Tester resource is modified, the snapshot can be updated 
using the Refresh button. If the test resource and snapshot are found to be out of 
sync, an asterisk will appear on the Refresh button. Additionally, refreshing the 
snapshot validates that the project and resource are available to the current user. 

9.	 To edit the selected resource in Rational Integration Tester, click the Edit button. 

NOTE:	 Rational Integration Tester must be installed on the user’s machine to 
utilize the editing feature, and Rational Integration Tester should not 
be running already when the Edit button is clicked. 

Rational Integration Tester will be launched, and the selected resource will be opened 
in the Test Factory perspective. 
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2.3 Executing Tests 
This section describes how to add Rational Integration Tester tests to test sets and 
configure them for execution in Quality Center. 

• Add Rational Integration Tester Tests to Test Sets 

• Setting an Environment for Rational Integration Tester Tests 

• Running Rational Integration Tester Tests 

2.3.1 Add Rational Integration Tester Tests to Test Sets 
Follow the steps below to add one or more Rational Integration Tester tests to a new 
or existing test set. 

1.	 Log in to Quality Center and select the Test Lab module. 

2.	 Select an existing test set or create a new one. 

3.	 Select the Execution Grid and, if not already visible, click Select Tests to display the 
Test Plan Tree. 

4.	 Add the desired tests from the Test Plan Tree to the current test set. 

Now the environment must be set for each Rational Integration Tester test in the test 
set (see Setting an Environment for Rational Integration Tester Tests). 
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2.3.2 Setting an Environment for Rational Integration Tester Tests 
Follow the steps below to set the environment for a Rational Integration Tester test, 
or to set a default environment for all tests in your Rational Integration Tester project. 

1.	 In the Test Lab module, open a test set (or create a new one) that contains your 
Rational Integration Tester tests (see Add Rational Integration Tester Tests to Test 
Sets). 

2.	 Open the Test Instance Properties/Details dialog for a selected Rational 
Integration Tester test (double-click the test in the Execution Grid, or right-click and 
select Test Instance Properties/Details). 

3.	 Open the Configuration or Execution Settings page and click the Automated tab. 

4.	 Select the desired environment from the combo box – you can select any of the 
environments in the project that contains the linked Rational Integration Tester test. 
To update the list of available environments, click Refresh. 

NOTE:	 If no environment is selected, the test will not be able to execute 
successfully. 

5.	 Click the Set as Default button to set the currently selected environment as the 
default environment for any tests linked to the same Rational Integration Tester 
project as the test being edited. 
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You will be prompted to confirm your selection. 

Using this option, if no environment is set explicitly for a test, it will use the default 
environment for the project to which it is linked. 

NOTE:	 If no default environment is set, the test will fail because tests in 
Rational Integration Tester require an environment to execute 
successfully. 

•	 To make an existing test instance (that is, one that has its environment specified) 
start using the default environment for the project instead of the specified test, set 
it to Base Environment. 

•	 To change the environment used for all tests linked from a Rational Integration 
Tester project, set all existing test instances to use Base Environment and then 
use the Set As Default option to set the environment that every test instance will 
use. 

•	 To remove the default environment set for a Rational Integration Tester project, 
simply set the default environment to Base Environment. 

NOTE:	 Default environments are a user setting within Quality Center, so they 
will be set only for the user who sets them. 

6.	 When finished, click Close or OK to close the Test Instance Properties/Details 
dialog. 
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2.3.3 Running Rational Integration Tester Tests 
After adding Rational Integration Tester tests to a test set and setting the environment 
options, you are ready to run your tests. 

1.	 In the Test Lab module, run the test set as you normally would (Run Test Set) – the 
execution is controlled in the Automatic Runner dialog. 

2.	 If all tests should be run on the local host, ensure that the Run All Tests Locally 
option is enabled, set the Enable Log option as desired, then click Run All or Run, 
as desired (to run a single test or all tests). 

While the test set is running, the progress of each test will be displayed in the Status 
column. 

3.	 Click Stop or Stop All if you need to halt the execution of one or all tests. 

4.	 When the tests have finished executing, you can close the Automatic Runner dialog. 
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2.4 Add Test Types for Filtering 
You can apply filters to the Test Lab to view a reduced number of items. Before you 
can filter on an item, however, it must be included in the applicable project list (for 
example, the “GH-TESTER” type in the TestType list). The following steps 
illustrate how to add an asset type to a project list using the GH-TESTER test type as 
an example. 

1. In the main Quality Center window, click the Tools menu and select Customize... 

2.	 In the Project Customization window, click the Project Lists link. 

3.	 In the Project Lists panel, select the TestType list from the Lists combo box, or in 
QC 11, simply select the TestType option. 

4.	 If “GH-TESTER” is not listed, click New Item at the bottom of the panel. 

NOTE:	 If “GH-TESTER” is already listed, nothing further is required and 
you can leave the Project Customization. 

5.	 In the New Item dialog, enter “GH-TESTER” (without the quotes) in the Item 
Name field, then click OK. 

6. Click Save in the Project Lists panel. 
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 7. After confirming the changes, click Return in the upper-right corner of the window 
to return to your last location in the project. 
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2.5 Viewing Execution Results 
Results for Rational Integration Tester tests and test suites that are executed from HP 
Quality Center can be viewed in the Results Gallery perspective of Rational 
Integration Tester. Within Quality Center, last run results can be viewed in the 
execution grid, and historical results can be viewed from the Test Instance 
Properties/Details dialog. 

The overall status of a test or test suite can be seen in the execution grid, and detailed 
results (taken from the Rational Integration Tester console) for the selected entry can 
be viewed in the Last Run Result window (below the grid). 

Historical results can be viewed under All Runs, in the Test Instance Properties/ 
Details dialog (double-click an entry in the execution grid, or right-click and select 
Test Instance Properties/Details). 

To view the detailed results for any run, select its entry and view the results in the 
lower half of the Test Instance Properties/Details dialog. 
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NOTE:	 In both places, if console output generated by Rational Integration 
Tester exceeds 100 lines, only the first 50 and the last 50 lines will be 
stored and displayed. 

Included in the console output are a link to view the execution results in Rational 
Integration Tester (in the Results Gallery) and a link to view the detailed report in 
Rational Integration Tester Results Server. The Results Server URL is generated 
according to the Results Server URL value in Rational Integration Tester’s project 
settings, and Results Server must be installed to view the detailed report. 

NOTE:	 If you don’t have a valid DB connection configured in Rational 
Integration Tester, the Results Server link is omitted from the output. 

If using Results Server, ensure that your Internet Explorer options are set to NOT 
reuse windows for launching shortcuts (under Tools > Internet Options, click the 
Advanced tab and disable this option under the Browsing group). 
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2.6 Running Rational Integration Tester Tests on Remote Hosts 
or Host Groups 

Quality Center allows test instances in a Test Set to be configured to run on a remote 
host. Hosts can also be placed in a Host Group for failover purposes. 

NOTE:	 When a Host Group is used, Quality Center tries each host in the 
group until it finds one that will run the test. 

Hosts and Host groups are created in the Test Lab by selecting Host Manager from 
the Test Sets menu. 

Hosts and Host Groups are specified in the Test Set by choosing one from the list in 
the Planned Host Name column for test instances in the Execution Grid tab. 

For more information about running tests on remote hosts, refer to HP Quality Center 
User’s Guide. 

Note the following requirements for running Rational Integration Tester tests on 
remote hosts: 

1.	 The remote machine must have a properly licensed copy of Rational Integration 
Tester installed. 

2.	 The Rational Integration Tester project(s) linked to the test(s) created in Quality 
Center must be located on the remote host in the exact same path. For example, if the 
project is located in C:\projects\myproject on the local machine, then the project 
must be found on the remote host in C:\projects\myproject. 

NOTE:	 To run a test on a remote host in Quality Center, Microsoft Windows 
DCOM must configured properly on both machines. If DCOM is not 
configured properly, you will receive an error (“Access is denied” or 
“RPC server is unavailable”) when trying to run the test. Additionally, 
the network user executing the test from Quality Center must have 
privileges to run processes on the remote host via DCOM. 
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Glossary
 

The following table below lists some of the key terms used in this document, and 
provides a description of each. 

Term Description 

Field A bit of data constituent to a message. Most fields are scalar and 
therefore unitary, equivalent to data attributes. Vector fields are 
an aggregation of fields both scalar and vector, and are usually 
referred to as Messages (see also Message, below). 

Message A unit of information made up of a header consisting of meta­
information and a body consisting of the message data. 

Host The computer on which a software process runs. 

Publish-Subscribe A messaging paradigm for efficient one-to-many communication 
in which one process (the publisher) sends information to zero or 
more other processes (subscribers). 

Transport Informally, the messaging software in use. For instance, TIBCO 
EMS, TIBCO ActiveEnterprise, IBM WebSphere® MQ (JMS). 

Publishing Making a message (data) available on a message channel. 

Subscribing Receiving a stream of messages (data) on a given message 
channel. 

Server A host computer on a network shared by more than one user. 

Subject A user-defined, meaningful name for identifying messages on 
transports. For example, the subject EQ.IBM might identify all 
pricing data about IBM stocks, while EQ.IBM.N might identify price 
data from the New York Stock Exchange only. 
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Notices
 

This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in 
other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right may be 
used instead. However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you any 
license to these patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM 
Intellectual Property Department in your country or send inquiries, in writing, to: 

Intellectual Property Licensing 
Legal and Intellectual Property Law 
IBM Japan, Ltd. 
1623-14, Shimotsuruma, Yamato-shi 
Kanagawa 242-8502 Japan 

The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
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MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some 
states do not allow disclaimer of express or implied warranties in certain transactions, 
therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements and/ 
or changes in the product(s) and/or the program(s) described in this publication at 
any time without notice. 

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs 
and other programs (including this one) and (ii) the mutual use of the information 
which has been exchanged, should contact: 

IBM United Kingdom Limited 
Intellectual Property Law 
Hursley Park 
Winchester 
SO21 2JN 
Hampshire 
United Kingdom 

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 

The licensed program described in this document and all licensed material available 
for it are provided by IBM under terms of the IBM Customer Agreement, IBM 
International Program License Agreement or any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary 
significantly. Some measurements may have been made on development-level systems 
and there is no guarantee that these measurements will be the same on generally 
available systems. Furthermore, some measurements may have been estimated 
through extrapolation. Actual results may vary. Users of this document should verify 
the applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those 
products, their published announcements or other publicly available sources. IBM has 
not tested those products and cannot confirm the accuracy of performance, 
compatibility or any other claims related to non-IBM products. Questions on the 
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capabilities of non-IBM products should be addressed to the suppliers of those 
products. 

All statements regarding IBM’s future direction or intent are subject to change or 
withdrawal without notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental. 

COPYRIGHT LICENSE: 

This information contains sample application programs in source language, which 
illustrate programming techniques on various operating platforms. You may copy, 
modify, and distribute these sample programs in any form without payment to IBM, 
for the purposes of developing, using, marketing or distributing application programs 
conforming to the application programming interface for the operating platform for 
which the sample programs are written. These examples have not been thoroughly 
tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, 
serviceability, or function of these programs. 

Each copy or any portion of these sample programs or any derivative work, must 
include a copyright notice as follows: 

© (your company name) (year). Portions of this code are derived from IBM Corp. 
Sample Programs. © Copyright IBM Corporation 2001, 2012. 

If you are viewing this information softcopy, the photographs and color illustrations 
may not appear. 
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Trademarks and service marks 
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions worldwide. 
Other product and service names might be trademarks of IBM or other companies. A 
current list of IBM trademarks is available on the Web at “Copyright and trademark 
information” at www.ibm.com/legal/copytrade.shtml. 

Microsoft and Windows are trademarks of Microsoft Corporation in the United 
States, other countries, or both. 

UNIX is a registered trademark of The Open Group in the United States and other 
countries. 

Java and all Java-based trademarks and logos are trademarks or registered trademarks 
of Oracle and/or its affiliates. 
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